INTRODUCTION.
# TABLE OF CONTENTS

1. First Steps ................................................................................................................................. 3
2. race result 11 Demo...................................................................................................................... 4
   2.1. How to Open an Event.............................................................................................................. 4
   2.2. How to Navigate in race|result 11 .......................................................................................... 5
   2.3. Participants Window................................................................................................................ 6
       General ........................................................................................................................................ 6
   2.4. Output Window ......................................................................................................................... 7
   2.5. Making Changes ....................................................................................................................... 8
   2.6. Participant Activation ............................................................................................................ 11
   2.7. How to Purchase Participant Credits ..................................................................................... 12
3. Create a New Event...................................................................................................................... 13
   3.1. How to Create A New Event.................................................................................................... 13
   3.2. How to Configure Events ...................................................................................................... 13
   3.3. Other (Advanced) Options / Settings .................................................................................... 17
   3.4. Online Registration ............................................................................................................... 18
   3.5. How to Create Race Certificates ........................................................................................... 20
   3.6. Further Options ...................................................................................................................... 21
4. Shortly Before Your Event .......................................................................................................... 22
   4.1. Download and Install race|result 11 ...................................................................................... 22
   4.2. Checking Out the Event File .................................................................................................. 22
5. During the Event.......................................................................................................................... 23
   5.1. Registration of Late Entrants .................................................................................................. 23
   5.2. Manual Time Keeping .......................................................................................................... 23
   5.3. Chip Time Keeping ............................................................................................................... 23
6. Right After Your Event............................................................................................................... 24
   6.1. Check-In of Your Event.......................................................................................................... 24
   6.2. Results on my.raceresult.com.............................................................................................. 24
   6.3. my.raceresult Complaints .................................................................................................... 24
1. **FIRST STEPS**

Before and after your event you should be working online via the Internet. That way, you will be able to collaborate with all of your team members and make changes to the event file, all at the same time. Simultaneously, while online, my.raceresult can access your event file to store all (new) online registrations and to publish up-to-date participant lists and results pages.

In order to access race|result 11 online, you need a customer account: if you already have an account, you can skip this step and continue by logging into your account by filling in your customer data in the top right hand corner.

If you do not have a customer account yet, follow the link “Register” to create a new account.
2. RACE RESULT 11 DEMO

2.1. How to Open an Event

In your customer area click on the button **start race\result 11** in order to access your events in the race\result software.

Welcome to Your Customer Area!

In the customer area you can start race result 11, check your orders, change your account data, and check and buy credits to manage your events using race result 11.

This **START** area of race\result 11 allows you to open existing events and to create new events. For illustration purposes, a demo event has been pre-installed.

Choose the **race\result 11 Demo** event by simply clicking on it. You can now see the more detailed overview of that particular event:
The main navigation can be found at the top of the screen: The **Main Window** allows to configure your event, create statistics, import participants’ data, etc. The **Participants** Window is designed to add, edit and delete individual participants. The **Output** Window creates and prints lists, result pages as well as race certificates. The **my.raceresult.com** tab allows you to set options that manage the publication of your event on my.raceresult.com, and the **Tools** tab provides additional tools such as the certificate designer.

The five small icons on the right-hand side give you additional orientation: via the **Chat** you can discuss anything you have on your mind with other race result users; the **race result Online Help** provides detailed information about the race|result software; the **Q&A section** serves to discuss specific questions you may have; the **News** section provides information about any recent developments at race|result; and the **Info** section shows the most relevant settings of your event.

### 2.2. How to Navigate in race|result 11

You can easily switch back and forth between the individual program tabs listed in the header.

We will now focus on the **Participants** Window and the **Output** Window first.
2.3. **Participants Window**

Each participant record contains a variety of different information that is grouped according to categories along the top of the screen: **General**, **Entry Fee**, **Results**, **History**, **Archives**, and **Certificates**.

**General** specifies the most basic participant information (e.g. name, year of birth, gender, etc.). **Results** shows all race results of that particular participant. You can also edit the results. Furthermore, this part presents all rankings (for example, Gender Rank, Age Group Rank, etc.) of the athlete. The **History** tab records all changes that have been made to the participant’s information. Being able to track the history is particularly helpful when there is confusion about race results or other data.

Provided you are using participant archives, you can see all recent runs / registrations of each individual athlete when clicking on **Archives**. Finally, the section **Certificates** allows you to view and print a single race certificate for the participant.

**Navigation**

On the left hand side, you will see a clearly structured list of commands that will help you browse through the participants. Browse the participant list by clicking on **Go to First** / **Go to Previous** / **Go to Next** / **Go to Last**. The function **Sort** (see below) specifies the metrics along which the participants are being sorted. You may also want to choose the **List View** in order to find specific participants quickly in a spreadsheet:


**Search**

In order to search for a specific participant, you can use the search field on the lower left side of the Participant Window. You will be fastest when searching for the bib number: simply click on the button **Bib** or press F8, enter the bib number and press "enter" / click on **Search**. You can also search in other specified fields or within all fields at the same time.

**Changing participant information**

If you need to change a participant’s data, you can simply click on the appropriate (text) field and change the information. Once you start making changes, a little disk symbol will appear in the upper left hand corner.

As soon as you want to save the changes without switching to a different data set, you can click on that disk symbol to save the newly entered info. The symbol in the upper left hand corner will then disappear.

Note: generally, race|result 11 saves all changes you have made when you navigate away to a different page (automatically), or if you click on the disk symbol (manually).

**How to add a participant**

To add a participant to your event, simply click on **New Participant** in the upper left hand corner or press F12. An empty form will appear where you enter the participant’s information. The document will again be saved automatically or manually.

2.4. **Output Window**

Click on **Output** to go to the Output Window which serves to create and print all kinds of lists as well as race certificates.
In the navigation bar on the left, we already pre-defined the most commonly used lists. This will save you time when configuring your event file and compiling result pages. After choosing a list, you can display the data in a variety of formats, e.g. PDF and HTML (and more). PDF is most suitable for printing. By choosing a contest in the lower left hand corner (instead of <All Contests>) you can filter the list accordingly.

Right above the lists, you can choose from a number of different pre-defined Certificate Sets, e.g. certificates for all age group winners for your award ceremony.

For more information and a detailed explanation on how to configure and customize lists as well as certificates, please refer to the Advanced Users Guide and the race\result Online Help.

2.5. Making Changes

In order to see how concrete changes affect the results sections, let’s make some modifications. Go to the Output Window and choose Half Marathon as well as the Result List AG (result list age groups). Then, click on the output format View. We will now change the race time of participant Marco Rohrer (4th in Age Group Seniors M40) so that he will move into second place. To make the necessary changes, go to the Participant Window and search for Marco Rohrer by searching for his bib number (= 3313). Next, click on Results and change his race time from 1:27:52.75 to 1:24:20.
As soon as you jump to the next text field, you can see how the Age Group Rank (=AGRank) changes from 4./37 to 2./37. Go back to the Output Window and click again on View. You will now be able to see the updated results list.

Next, we will modify Marco Rohrer’s year of birth which will shift him into a different age group. Access the Participant Window and click on General. Change the year of birth from 1976 to 1971. The change will be reflected immediately by changing his age group from Seniors M40 to Seniors M45 automatically.

In the upper left hand corner, you will again see the disk symbol which means that the change has not been saved, yet. Now, click on History – navigating away now saves the change automatically. race\result 11 saves all modifications when navigating to a different tab, participant, or when you click on the disk symbol. Looking at the History of this participant, you now see all modifications that have been made to this particular participant so far:
If you go back to the results list (Result List AG) in the Output Window, you will see that Marco Rohrer is now included in age group M45 with a race time of 1:24:20. He is third in that age group.

Next, we will add a new participant manually. Go to the Participant Window, click on New Participant or press F12, and fill in the empty form. Also specify which contest the newly added participant is registered for:
Go back to the **Output** Window (again changes you have made will be saved automatically) and open the list **Participants List**.

At the bottom of the participant list you can see that the newly added athlete John Smith is not being displayed correctly, but garbled by underscores. The following section explains why.

### 2.6. Participant Activation

**race|result 11** uses a credit-based payment model: that means, you do not have to buy the software, but instead purchase race|result Credits. This fee per participant includes all our services: scoring, online registration, participant- and result lists as well as certificates on my.raceresult.com, support, server usage, etc. This model has proven to be fair and advantageous for all event organizers as even very small organizers can now manage, time and score their races using professional software at a low price.

Billing happens every night between 2am and 6am: One race|result credit will be taken from your account for every new participant. If you add participants for tests and delete these before the night, this will be free of charge.

Also, you can define an event as “test event” in the **Main Window** tab at **Basic Settings**. In this case, you will not be charged for the participants, but instead the underscores will show up in your lists so that you cannot use them for a real event. The demo file is defined as test event which is why the underscores appeared for John Smith.

The underscores will also appear if the nightly activation fails, for example, when you do not have sufficient credits in your account.
2.7. How to Purchase Participant Credits

You can find prices for the credits on our website www.raceresult.com in the section SOFTWARE → RACE|RESULT 11 → Pricing. Unused participant credits are not lost, but can be used for your next event. It will be most cost-efficient to purchase participant credits in bulk as the per participant cost decreases as you buy a larger amount at once.

Once you have made the decision to use race|result 11 for your event, go to your Customer Area and click on Buy/Transfer Credits where you find the following form to buy race|result credits:

When clicking the Buy Now button, you will be forward to the shop for the checkout process.
3. CREATE A NEW EVENT
Having gained first insights into race\result\, we now show you how to create and configure your own event. First, go to the START tab in race\result\ (in the top left corner).

3.1. How to Create A New Event
Click on Create New Event and enter your event name and the event date. Use the format “yyyy-mm-dd” (for example, use “2016-08-13” for an event on August 13, 2016). Optionally, you can also choose a pre-configured event type (e.g. a lap race) or create a copy of an existing event file:

3.2. How to Configure Events
Once again, you will be directed to the Overview Window and can now also choose between Main Window, Participants window, Output window and the other key functions in the header area. First, open the Main Window. In the navigation bar on the left, you find the category Basic Settings, which specifies all options for your event.

Event
First, click on Basic Settings in order to set all general settings for your event:
You can still change the name and date of your event. Also, specify the Event Type and where the event takes place (Zip, City, Street / Location). If your event is longer than a single day, you can also define a time period for your event. Other options in this area include setting (optional) passwords, inserting general comments and weather conditions.

**Contests**
Next, click on Contests where you can specify the individual contests/races included in your event. You may, for example, define a 5k run, a 10k run, and a Half Marathon. Two contests have been predefined and inserted by default. If you plan on offering more than two contests, you can add more by clicking on Create New Contest. You may also delete an unnecessary contest by clicking the tab for that contest and then clicking Delete.

In the first section (General), you should specify the contest’s identification number (ID), name, distance in meters, and finally the start time. The Participants section on the right determines who is eligible. This part has, for instance, an effect on who is allowed to register for the event using the online registration on my.raceresult.com. If you add non-eligible participants manually, you will receive a warning.

**Times** defines how to deal with the race times of this contest, how to round and format individual times. Finish Result only needs to be modified if you plan on having more than one result per participant (see below), e.g. interim and finish times. The next section, **Ranks**, determines the order in which participants are being ranked for this contest. Usually, you do not have to make any modifications here.\(^1\)

**Participant Configuration**
The Participant window contains a large number of input- and text fields. Most likely, you will not need all of them, but sometimes additional fields may be required. In **Settings->Participants** you specify the input- and text fields which are displayed when adding and editing participants.

\(^1\)By default, ranks are sorted first by **Status** (which ensures that e.g. disqualified participants will be at end of the results list) and then by the **DecimalTime** (time expression in seconds) of the finish result.
The first part of the screen shows the default fields that you can either activate or deactivate (e.g. Nationality, Street, etc.). In case you need additional input fields, you can activate 20 Additional Text Fields (=ATF) and 20 Additional Yes/No Fields (=AYN). An ATF allows you to enter any desired text or value, e.g. T-Shirt size. The individual values that describe the T-Shirt sizes have to be entered into the text field Optional Fixed Values (e.g. ;S;M;L;XL). An AYN can only be activated or deactivated, e.g. participation at a pasta party before the race.

When opening the Participant window, you will now find only those input- and text fields tailored to your requirements.

**Bib Ranges**

The next section allows you to define certain bib ranges for each contest. You can even define several bib ranges for one contest, e.g. Half Marathon – 3001-3600 and 4001-4800.
Defining bib ranges for each contest is optional, but having a clearer structure for your bib numbers can make adding participants much easier later on. You then have two options to deal with new entries based on bib ranges: use bib ranges to propose a contest and use bib ranges to propose a bib number. In the first case, the contest will be set automatically when entering the bib number for a new participant. This scenario is most suitable for late entries during the event. The latter case searches for an available bib number after choosing the contest the new participant will compete in. This option should be chosen during pre-registration before the event.

**Age Groups**

In the settings menu, **Age Groups** defines all age categories / groups.

By default some age groups are already created, but you can always change the predefined categories and customize them to your specific needs. It is possible to define common age groups for all contests, or different age groups for each contest. For the latter activate the checkbox **Separate Age Groups for each Contest**.

In case you require two different age group scores for each participant, you can define a second **Age Group Set**. In order to enter the second Age Group Set, simply choose **Age Group Set 2** from the drop down menu.

**Entry Fees**

Next, we’ll look at settings for the entry fees. Defining entry fees is important for payment during online registration. Additionally, you can print the entry fee on lists, labels, etc.
You can define a variety of fees for each contest, which can be charged either for all participants or only those who registered in a certain time period or those of a certain age or those fulfilling certain criteria (for example t-shirt ordered). The total entry fee will be calculated by summing up all applicable entry fees. Here some examples:

- Entry fee of $10 for all participants: Name the entry fee e.g. „General Entry Fee“, enter the value of $10 and make sure that 01/01/1900 – 12/31/2100 is entered as „Born Between“ and „Registered between“.
- Increase by $2 from 07/19/2016 on: define the entry fee as above, but enter „01/01/1900 – 07/18/2016“ in „Registered between“. Then, define a second entry fee with value $12 and set „07/19/2016-31/12/2100“ as „Registered between“. Make sure that the date spans do not overlap and that there are not gaps (otherwise you may register for free for one day).
- Additional $5 for everyone who ordered a t-shirt (if a t-shirt was ordered, the size is in Additional Textfield 1, ATF1): Create a new entry fee with value $5 and enter the
  - Optional Filter: ATF1 <> (empty)
- Number of pasta party coupons saved in ATF2, $3 per coupon: Create a new entry fee with value $3 and select ATF2 in Multiply with (in the advanced settings >>).

3.3. Other (Advanced) Options / Settings

Results and Ranks
It is possible to save several times for each participant, e.g. a start time, interim result(s), and a finish time. Check out the Advanced Users Guide and the topic Results in the race\result Online Help for a detailed explanation.

race\result 11 also enables you to calculate special ranks for each participant. By default, the program already computes the overall rank, the gender-rank as well as the age group rank. Again, please refer to the Advanced Users Guide and the race\result Online Help to see how additional customized ranks can be programmed.

Team Scores
A Team Score is used to group several participants (e.g. from the same club or company) to build one team, and subsequently rank each team. The Advanced Users Guide and race\result Online Help explain in detail how to configure team scores.

Archives
You can archive all data of your event. Using the archives, you can then add new participants very quickly by simply importing individual athletes from the archives. Take a closer look at the Online Help topic
Archives to gain a deeper understanding of archived data as well as how to use the archives to add new participants.

### 3.4. Online Registration

Most likely, to save time and money you will want to offer online registration for your event. Included in our service is free usage of our sports portal my.raceresult (http://my.raceresult.com) which lists your event so that race participants can find you quickly and easily.

Your event page on my.raceresult.com contains the pages **Info** (for general information), **Registration** (for online registration), **Participants** (in order to publish participant lists), **Results** (for the publication of result lists and certificates), **Reviews** (for comments), and **Contact** (to contact the event organizer or time keeper).

All settings can be accessed through the **my.raceresult.com** tab in race|result 11. We will now address each setting in more detail.

#### Basic Settings

In order to publish your event on my.raceresult.com, click on the tab **my.raceresult.com** at the top of the general window. Then, accept the general terms of use and activate the checkbox Publish event on my.raceresult.com.
An individual cover picture is recommended and gives your event a special touch.

The following Basic Settings allow you to make changes to the “Info” and “Contact” page and to choose between different options for comments left on the result list 2.0 as well as change settings for the “Reviews” page.

**Online Registrations**

The options that refer to the online registration can be set in the section **Online Registration**. Activate the checkbox **Activate Online Registration** in the basic settings overview in order to enable online registration on my.raceresult.com. Scrolling down, you find all other important settings referring to, for instance, registration period and rules of participation.

In this part of the navigation (Online Registration), you can also define the settings for the Online Payment of entry fees, specify the text of confirmation emails athletes receive after registering for your event as well as the data that will be collected from participants during the registration process (**Form Fields**).

**Publishing**

In the section **Publishing** you can define which lists and certificates from the **Output** Window, and which links will be published on my.raceresult.com. The certificates and links can then be accessed by clicking on a participant’s name in a result list.

In order to publish a list or a certificate, simply select it in the drop-down box and define for which contest it shall be published.
3.5. How to Create Race Certificates

If you want to print race certificates for your event and/or offer certificates online for participants to download, you need to configure your certificates first. This is done in the Designer which can be found in the Tools tab.
You can choose from three types of pre-defined certificates on the left: **Team Certificate**, **Certificate + Background**, and **Certificate**. The simple and standard Certificate is intended for prints on pre-printed paper. Certificate + Background is intended to contain a background picture and will be offered to participants online for download.

More detailed information about how to use the Designer to create and configure your own certificates can be found in the Advanced Users Guide and the race\result Online Help (topic “Designer”).

### 3.6. Further Options

Your event has now been configured. Of course, you can add details and special options to your event by:

- Creating new and customized lists for your event
- Customizing the existing lists: e.g. by inserting pictures, formatting font style and size, changing page frames, etc.
- Creating certificate sets that you may want to print during your event
- etc.
4. **SHORTLY BEFORE YOUR EVENT**

Most likely, you will not have reliable Internet access during the event. Even if you do have an Internet connection, we recommend that you work offline during the event: this will help reduce issues in case the connection is lost for any reason. Two steps are necessary: 1) you have to install the latest version of race\result\num\num on your computer, and 2) download the event file and save it on your hard drive.

4.1. **Download and Install race\result\num\num**

The latest version of race\result\num\num can be downloaded on our website www.raceresult.com. Go to SOFTWARE > DOWNLOAD. Download and start the installation file and then follow the instructions that guide you through the installation.

After the installation launch the **race\result Web Server** in your Windows start menu or on your desktop.

4.2. **Checking Out the Event File**

Currently, your event file is still saved online on the Internet. Shortly before your event starts, you will want to download your file and continue working on it in offline mode. Consequently, your master file will then be stored offline on your computer. This process is called Check-Out. In order to check out an event, go to the race result Web Server and click on **Online > Download an Event from Server (Check-Out)**. Once you have checked-out your event file, you will not be able to open it online anymore. This way, you ensure that changes can only be made to the master file and confusions are avoided.

Note that your online registration has to be closed in order to be able to check-out an event.

In case you would like to experience the check out function and work offline on your computer for test reasons before online registration is closed, you can download your file by activating the checkbox **Download a copy of this event, original remains online**.

Once your event has been checked out and saved on your computer, you can always open it by clicking on **File>Open Event**. You then have access to your event simply by clicking **Open Event** in the race\result Web Server which opens your web browser and brings you the Overview page of your chosen event.
5. **DURING THE EVENT**

Next, we will describe the most important steps for using race\result\ 11 on race day.

5.1. **Registration of Late Entrants**

Usually, event organizers have to enter participants after online registration is closed, i.e. you have to enter late entrants manually. If you have more than one laptop available, we recommend that you add all computers to a local network. This way, your staff can work on entering new participants simultaneously and thus save time and make the best use of your available resources. All connected laptops can then access the main computer and the master file through the browser.

The race\result\ Web Server displays the network address at the bottom left corner (see picture: http://192.168.1.64/). Simply enter this URL in the browser of any computer in your local network to access your event file.

Once you have entered the abovementioned address in the browser, you will be directed straight to the **START** page of race\result\ 11:

Now, you can access the event file simply by clicking on it in the list. All you need is a browser, you do not need to install race\result\ 11 on every single computer.

5.2. **Manual Time Keeping**

For manual time keeping (instead of chip time keeping), we offer additional programs that work together to record the times of all finishers. Please refer to the separate *Manual Timing Guide* if you plan on using manual time keeping for your event.

5.3. **Chip Time Keeping**

When using chip time keeping, you will use the *Transponder Module* to create a connection between the timing system and your event file. Please find detailed information in the Practical Guide for the race\result\ System and in the race\result\ Online Help (topic Transponder Module).
6. **RIGHT AFTER YOUR EVENT**

6.1. **Check-In of Your Event**
Right after the event, you want to upload your master event file to the Internet. This will have two effects: first, your results will be available on my.raceresult.com, and secondly, you and your colleagues can then collaborate again online and work on the event file simultaneously.

This process is called Check-In. As soon as your event file is checked (back) in, the offline file will be closed and changes can only be made online after logging into your account on www.raceresult.com. Thus, be sure to only check-in your event, if you are certain that you do not want to make further modifications to the offline file. In order to check-in your event, click on **Online > Move this Event to Server (Check-In)**.

6.2. **Results on my.raceresult.com**
If you have not done so already, select the result lists and certificate sets that you would like to publish on my.raceresult.com.

6.3. **my.raceresult Complaints**
my.raceresult.com also offers you an extra form to collect feedback and complaints from participants. This form can be found in the section **Contact** on my.raceresult.com. When participants fill in this form, the complaint can be found in the **my.raceresult.com** tab of race|result 11 under the headings **Complaints > Handle Complaints**.

When processing complaints, all result lists and certificates on my.raceresult.com are updated automatically. Of course, the same goes for changes that you make in the **Participant** window or anywhere else in race|result 11.